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Introducing Microsoft Project 2010
Microsoft Project 2010 is a powerful program that helps you plan and manage a wide 
range of projects. From meeting crucial deadlines and budgets to selecting the right 
resources, Project 2010 offers easier and more intuitive experiences to help you be more 
productive and realize better results. You can use Project to:

●	 Create project plans at the level of detail that’s right for your project. Work with 
summary data initially or shift to a more detailed approach when it’s convenient. 
Control what tasks Project can schedule automatically or that you’ll schedule 
manually.

●	 Manage tasks, costs, work, and resources at whatever level of detail is appropriate 
for your project’s needs.

●	 See your project plan data in a variety of views. Apply grouping, highlighting, sort-
ing, and filtering to see your data the way that you want.

●	 Track and manage your project plan throughout project execution. 

●	 Collaborate and share data with others in your organization using a variety of pro-
ductivity applications.

●	 Use resource pools, consolidated projects, and cross-project links to extend your 
project management focus across multiple projects. 

Project 2010 builds on previous versions to provide powerful project management tools. 
This introduction provides an overview of new features that we explore throughout the 
book.

New Features
If you’re upgrading to Project 2010 from a previous version, you’re probably most inter-
ested in the differences between the old and new versions and how they will affect you. 
The following sections list new features you will want to be aware of, depending on the 
version of Project you are upgrading from.
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If You Are Upgrading from Project 2007
If you have been using Project 2007, you might be wondering what new features and 
interface changes Microsoft has added to its desktop project management application. 
The list of new features includes the following:

●	 The Microsoft Office Fluent interface (the “ribbon”)  No more hunting through 
menus, submenus, and dialog boxes. This new interface organizes all the com-
mands that most people use in a new way, making them quickly accessible from 
tabs at the top of the program window.

●	 The Backstage view  Finally, all the tools you need to work with your files are 
accessible from one location. 

●	 Manually scheduled tasks  Begin creating tasks with whatever information 
(numeric or text data) you may have, and don’t worry about automatic scheduling 
of tasks until you’re ready. Manually scheduled tasks are not affected by changes in 
duration, start or finish dates, dependencies, or other issues that otherwise would 
cause Project to reschedule a task. You can then switch individual tasks or an entire 
project plan from manual to automatic scheduling. 

●	 Timeline view  Create a visually compelling “project at a glance” view that includes 
just the summary tasks, tasks, and milestones that you choose. Easily copy the 
Timeline view as a graphic image to paste into other applications.

●	 Better pasting to Excel and Word  Paste Project data into Excel or Word and 
preserve the column headings and outline structure of your Project data. 

●	 Customizable ribbon  Create your own tabs and groups to suit the way you work.

●	 Custom fields  Just start typing a numeric value, date value, or text string into the 
rightmost column in a table, and Project will identify the right data type.

●	 AutoFilter improvements  Use Microsoft Excel–like filtering, as well as sorting and 
grouping, right from AutoFilter arrows on column headings.

●	 Save as PDF or XPS  Create PDF or XPS format documents directly from Project.

●	 Team Planner view (Project Professional only)  Perform actions like reassigning a 
task from one resource to another with simple dragging in the Team Planner view.

●	 Inactivate tasks (Project Professional only)  Disable (but don’t delete) selected 
tasks from a project plan so they have no effect on the overall schedule but can be 
reactivated later if you need them. 
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●	 SharePoint Task List integration (Project Professional only)  Publish and 
synchronize tasks between Project and a new type of Microsoft SharePoint list 
called a Project Task List.

If You Are Upgrading from Project 2003
In addition to the features listed in the previous section, if you’re upgrading from Project 
2003, you’ll want to take note of the new features that were introduced in Project 2007. 
The 2007 upgrade included several new and improved features, including the following:

●	 Visual reports  Export Project task, resource, or assignment details to Excel or Visio 
in a highly structured graphical format. 

●	 Change highlighting  See what values changed throughout a project plan 
immediately after you make a change to a calculated task, resource, or assignment 
value.

●	 Cost resources  Assign this special type of resource to tasks to accrue categories of 
costs you wish to track, like travel or entertainment. Cost resources have no effect 
on the scheduling of tasks to which they are assigned.

●	 Task Inspector pane  Called the Task Driver pane in Project 2007, the Task Inspector 
pane shows you details that affect the scheduling of a selected task.

●	 Multi-level Undo  Back out of a series of actions when you need to. 

●	 Calendar working time exceptions  Record not just the date, but also an explana-
tion of a resource or project calendar working time exception. 

Let’s Get Started!
We’ve been working with Project since it debuted for Windows, and each version has 
offered something that made project planning and management a little easier. Project 
2010 is a substantial update for desktop project management, and we look forward to 
showing you around.
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Modifying the Display of the Ribbon
The goal of the Microsoft Office working environment is to make working with Office 
documents, including Microsoft Project plans, Microsoft Word documents, Microsoft 
Excel workbooks, Microsoft PowerPoint presentations, Microsoft Outlook e-mail 
messages, and Microsoft Access database tables, as intuitive as possible. You work with 
an Office document and its contents by giving commands to the program in which the 
document is open. All Office 2010 programs organize commands on a horizontal bar 
called the ribbon, which appears across the top of each program window whether or not 
there is an active document.

Ribbon tabs Ribbon groups

�A typical program window ribbon.

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some 
appear in galleries. Some groups have related dialog boxes or task panes that contain 
additional commands. 

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this topic, we discuss the general appearance of 
the ribbon, things that affect its appearance, and ways of locating commands that aren’t 
visible on compact views of the ribbon.

See Also  For detailed information about the ribbon in Microsoft Project, see the section “The 
Ribbon and Tabs: Finding the Features You Want,” in Chapter 1, “A Guided Tour of Project.” 
For information about customizing the ribbon and other parts of the Project interface, see 
Chapter 16, “Customizing Project.”

Tip  Some older commands no longer appear on the ribbon but are still available in the 
program. You can make these commands available by adding them to the Quick Access 
Toolbar. For more information, see the section “Customizing the Ribbon and Quick Access 
Toolbar,” in Chapter 16, “Customizing Project.”
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Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the 
ribbon in the form of a large button, a small button, a small labeled button, or a list 
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons on 
the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Task 
tab of the Project program window are spread out and you’re able to see more of the 
commands available in each group.

Drop-down list
Small labeled
button

Large button

�The Task tab of the Project program window at 1280 pixels wide.

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons hide under one button that represents the group. Click the group button to 
display a list of the commands available in that group.

Group buttonSmall unlabeled buttons

�The Task tab of the Project program window at 800 pixels wide.

When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.
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Scroll arrow

�The Task tab of the Project program window at 393 pixels wide.

Changing the Width of the Ribbon
The width of the ribbon depends on the horizontal space available to it, which in turn 
depends on these three factors:

●	 The width of the program window  Maximizing the program window provides the 
most space for ribbon elements. You can resize the program window by clicking 
the button in its upper-right corner or by dragging the border of a non-maximized 
window.

Tip  On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen.

●	 Your screen resolution  Screen resolution is the size of your screen display 
expressed as pixels wide × pixels high. The greater the screen resolution, the 
greater the amount of information that will fit on one screen. Your screen 
resolution options depend on your monitor. At the time of writing, possible screen 
resolutions range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the 
greater the number of pixels wide (the first number), the greater the number of 
buttons that can be shown on the ribbon, and the larger those buttons can be.

On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution window of Control Panel. 
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�You set the resolution by dragging the pointer on the slider.

●	 The density of your screen display  You might not be aware that you can change 
the magnification of everything that appears on your screen by changing the 
screen magnification setting in Windows. Setting your screen magnification to 
125% makes text and user interface elements larger on screen. This increases the 
legibility of information, but it also means that less fits onto each screen.

On a computer running Windows 7, you can change the screen magnification from 
the Display window of Control Panel.
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�You can choose one of the standard display magnification options or create another by 
setting a custom text size.

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact, they are both used in the Windows dialog box 
in which you change the setting.) The greater the dpi, the larger the text and user 
interface elements appear on screen. By default, Windows displays text and screen 
elements at 96 dpi. Choosing the Medium - 125% display setting changes the dpi 
of text and screen elements to 120 dpi. You can choose a custom setting of up to 
500% magnification, or 480 dpi, in the Custom DPI Setting dialog box.

�You can choose a magnification of up to 200% from the lists or choose a greater 
magnification by dragging across the ruler from left to right.
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See Also  For more information about display settings, refer to Windows 7 Step by Step 
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows XP 
Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.

Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen resolu-
tion of 1280 × 800, at 100% magnification, and the default text size (96 dpi). If any of 
your settings are different, the ribbon on your screen might not look the same as the 
one shown in the book. For example, you might see more or fewer buttons in each of 
the groups, the buttons you see might be represented by larger or smaller icons than 
those shown, or the group might be represented by a button that you click to display the 
group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this 
format:

●	 On the Project tab, in the Properties group, click Project Information.

If the command is in a list, we give the instruction in this format:

●	 On the View tab, in the Data group, click Tables and then click Cost.

The first time we instruct you to click a specific button in each exercise, we display an 
image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to 
look different from the one shown in the book, you can easily adapt the steps to locate 
the command. First, click the specified tab. Then locate the specified group. If a group 
has been collapsed into a group list or group button, click the list or button to display 
the group’s commands. Finally, look for a button that features the same icon in a larger 
or smaller size than that shown in the book. If necessary, point to buttons in the group to 
display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.
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Features and Conventions of This Book
This book has been designed to lead you step by step through many of the tasks you’re 
most likely to want to perform in Microsoft Project Professional 2010 or Microsoft 
Project Standard 2010. If you start at the beginning and work your way through all the 
exercises, you will gain enough proficiency to be able to create and work with a wide 
range of Project features. However, each topic is self contained. If you have worked with 
a previous version of Project, or if you completed all the exercises and later need help 
remembering how to perform a procedure, the following features of this book will help 
you locate specific information:

●	 Detailed table of contents  Search the listing of the topics and sidebars within 
each chapter.

●	 Chapter thumb tabs  Easily locate the beginning of the chapter you want.

●	 Topic-specific running heads  Within a chapter, quickly locate the topic you want 
by looking at the running heads at the top of odd-numbered pages.

●	 Glossary  Look up the meaning of a word or the definition of a concept. 

●	 Detailed index  Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information.

Convention Meaning
SET UP This paragraph preceding a step-by-step exercise indicates the 

practice files that you will use when working through the exer-
cise. It also indicates any requirements that you should attend to 
or actions that you should take before beginning the exercise.

CLEAN UP This paragraph following a step-by-step exercise provides in-
structions for saving and closing open files or programs before 
moving on to another topic. It also suggests ways to reverse any 
changes you made to your computer while working through the 
exercise.

1
2

Numbered steps guide you through hands-on exercises in each 
topic, as well as procedures in sidebars and expository text.

Important This paragraph points out information that you need to know to 
complete a procedure.
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Convention Meaning
Note This paragraph describes information that merits special attention.

See Also This paragraph directs you to more information about a topic in 
this book or elsewhere.

Tip This paragraph provides a helpful hint or shortcut that makes 
working through a task easier.

Ctrl+G A plus sign (+) between two keys means that you must press 
those keys at the same time. For example, “Press Ctrl+G” means 
that you should hold down the Ctrl key while you press the G key.
Pictures of buttons appear in the margin the first time the button 
is used in a chapter.

Bold In exercises that begin with SET UP information, bold type dis-
plays text that you should type; the names of program elements, 
such as buttons, commands, windows, and dialog boxes; and 
files, folders, or text that you interact with in the steps.

Bold italic Terms that are defined in the Glossary are formatted this way.
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Using the Practice Files
Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, as well as other information, can be down-
loaded from the book’s detail page, located at:

http://go.microsoft.com/fwlink/?Linkid=191765

Display the detail page in your Web browser and follow the instructions for downloading 
the files.

Important  The Microsoft Project 2010 program is not available from this Website. You should 
purchase and install that program before using this book.

The following table lists the practice files for this book.

Note  The same set of practice files works with both Microsoft Project Professional 2010 
and Microsoft Project Standard 2010. Differences between the two editions of Project are 
explained where needed throughout the book.

Chapter File
Chapter 1: A Guided Tour of Project Guided Tour_Start.mpp
Chapter 2: Creating a Task List (no initial practice file)
Chapter 3: Setting Up Resources Simple Resources_Start.mpp
Chapter 4: Assigning Resources to Tasks Simple Assignments_Start.mpp
Chapter 5: Formatting and Sharing Your Plan Simple Formatting_Start.mpp
Chapter 6: Tracking Progress on Tasks Simple Tracking_Start.mpp
Chapter 7: Fine-Tuning Task Details Advanced Tasks A_Start.mpp

Advanced Tasks B_Start.mpp
Chapter 8: Fine-Tuning Resource Details Advanced Resources_Start.mpp
Chapter 9: Fine-Tuning Assignment Details Advanced Assignments A_Start.mpp

Advanced Assignments B_Start.mpp
Chapter 10: Fine-Tuning the Project Plan Advanced Plan_Start.mpp
Chapter 11: Organizing Project Details Advanced Organizing_Start.mpp
Chapter 12: Tracking Progress on Tasks and 
Assignments

Advanced Tracking A_Start.mpp
Advanced Tracking B_Start.mpp
Advanced Tracking C_Start.mpp
Advanced Tracking D_Start.mpp

Chapter 13: Viewing and Reporting Project 
Status

Reporting Status_Start.mpp
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Chapter File
Chapter 14: Getting Your Project Back on Track Back on Track_Start.mpp
Chapter 15: Applying Advanced Formatting and 
Printing

Advanced Formatting_Start.mpp

Chapter 16: Customizing Project Customizing A_Start.mpp
Customizing B_Start.mpp

Chapter 17: Sharing Project Information with 
Other Programs

Sample Task List.xls
Sharing_Start.mpp

Chapter 18: Consolidating Projects and 
Resources

Consolidating A_Start.mpp
Consolidating B_Start.mpp

Your Companion eBook
The eBook edition of this book allows you to:

●	 Search the full text

●	 Print

●	 Copy and paste

To download your eBook, please see the instruction page at the back of this book.
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Getting Help
Every effort has been made to ensure the accuracy of this Microsoft Press book. If you 
run into problems please contact the appropriate source, listed in the following sections, 
for help and assistance.

Getting Help with This Book and Its Practice Files
The practice files referred to throughout this book are available as Web downloads. For 
more information, see “Using the Practice Files,” at the beginning of this book. 

If your question or issue concerns the content of this book or its practice files, please first 
consult the book’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=191765

This page provides information about known errors and corrections to the book. If 
you do not find your answer on the errata page, send your question or comment to 
Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with Project 2010
If your question is about Microsoft Project 2010, not about the content of this book or its 
practice files, please search Microsoft Support or the Microsoft Knowledge Base at:

http://support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. The 
Microsoft software support options available from Microsoft Product Support Services 
are listed at:

http://support.microsoft.com/gp/selfoverview/
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	 3	 Setting Up Resources
In this chapter, you will learn how to:

✔	 Set up basic resource information for the people who work on projects.
✔	 Adjust the maximum capacity of a resource to do work.
✔	 Set up cost information for work resources.
✔	 Change a resource’s availability for work.
✔	 Enter cost resource information for financial tracking.
✔	 Record additional information about a resource in a note.

Microsoft Project 2010 supports three types of resources. These are work resources, as 
well as two special-purpose resources: cost and material. Briefly, here is how to think 
about the three resource types:

●	 Work resources include the people and equipment needed to complete the tasks 
in a project.

●	 Cost resources represent a financial cost associated with a task that you need to 
account for. Examples include categories of expenses like travel, entertainment, and 
so on.

●	 Material resources are consumables that you use up as the project proceeds. For 
example, a construction project might need to track steel or concrete as it is used 
throughout the project.

In this chapter you will set up work and cost resources. Material resources are described 
in Chapter 8, “Fine-Tuning Resource Details.” 

In this chapter, you will set up the work and cost resources that you need to complete 
the new book launch at Lucerne Publishing. Effective resource management is one of the 
most powerful advantages of using Project instead of task-focused planning tools, such 
as paper-based organizers. You do not need to set up resources and assign them  
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to tasks in Project; however, without this information, you might be less effective in man-
aging your schedule. Setting up resource information in Project takes a little effort, but 
the time is well spent if your project is primarily driven by time or cost constraints (and 
nearly all projects are driven by one, if not both, of these factors).

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. A complete list of practice files is provided 
in “Using the Practice Files” at the beginning of this book. For each exercise that has a 
practice file, simply browse to where you saved the book’s practice file folder.

Important  If you are running Project Professional, you may need to make a one-time setting 
change. This helps ensure that the practice files you work with in this chapter do not affect 
your Project Server data. For more information, see Appendix C, “Using the Practice Files if 
Connected to Project Server.”

Setting Up Work Resources
Work resources are the people and equipment that do the work of the project. Project 
focuses on two aspects of work resources: their availability and their costs. Availability 
determines when specific resources can work on tasks and how much work they can 
perform, and costs refer to how much money will be required to pay for those resources. 

Some examples of work resources are listed in this table.

Work Resource Example
Individual people identified by name. Jun Cao; Zac Woodall
Individual people identified by job title or function. Publisher; Contract specialist
Groups of people who have common skills. (When
assigning such interchangeable resources to a task, 
you might not be concerned about who the individual 
resource is so long as they have the right skills.)

Copyeditors; Typesetters

Equipment. Offset lithography press
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Equipment Resource Considerations

In Project, you set up people and equipment resources in exactly the same way; 
they are both examples of work resources. However, you should be aware of 
important differences in how you can schedule these two work resources. Most 
people resources have a working day of typically 8 and usually no more than 
12 hours, but equipment resources might have much more varied capacities for 
work, ranging from short durations (followed by maintenance) to around the clock 
without interruption. Moreover, people resources might be flexible in the tasks they 
can perform, but equipment resources tend to be more specialized. For example, 
a content editor for a book project might also act as a copyeditor in a pinch, but a 
desktop copy machine cannot replace a printing press.

You do not need to track every piece of equipment that will be used in your 
project, but you might want to set up equipment resources when

●	 Multiple teams or people might need a piece of equipment to accomplish 
different tasks simultaneously, and the equipment might be overbooked.

●	 You want to plan and track costs associated with the equipment.

Consider these issues if your projects involve equipment resources.

Project can help you make smarter decisions about managing work resources and 
monitoring financial costs.

In this exercise, you enter the names of several people resources.

SET UP  Start Project if it’s not already running.

�You need the Simple Resources_Start project plan located in your Chapter03 practice 
file folder to complete this exercise. Open the Simple Resources_Start project plan, 
and then follow these steps.

	 1.	 On the File tab, click Save As.

Project displays the Save As dialog box.

	 2.	 In the File name box, type Simple Resources, and then click Save.

Tip  You can instruct Project to automatically save the active project plan at predefined 
intervals, such as every 10 minutes. On the File tab, click Options. In the Project Options 
dialog box, click Save, select the Auto Save Every check box, and then specify the time 
interval you want.

	 3.	 On the View tab, in the Resource Views group, click Resource Sheet.
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You will use the Resource Sheet view to enter the initial list of resources for the new 
book launch project.

	 4.	 Click the cell directly below the Resource Name column heading.

	 5.	 Type Jun Cao, and press the Enter key.

Project creates a new resource. 

 	 6.	 On the next empty rows in the Resource Name column, enter the following 
names:

Sharon Salavaria

Toby Nixon

Toni Poe

Zac Woodall

When you create a new work
resource, Project assigns it 100%
Max. Units by default.

These are all individual people. You can also have a resource that represents mul-
tiple people. You’ll enter such a resource next.

	 7. 	In the Resource Name field, below the last resource, type Copyeditors, and then 
press Enter.
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What Is the Best Way to Enter Resource Names?
In Project, work resource names can refer to specific people (Sharon Salavaria) or 
to specific job titles, such as Publisher or Contract Specialist. Use whatever naming 
convention makes the most sense to you and to those who will see your project 
plan information. The important questions are: who will see these resource names, 
and how will they identify the resources? The resource names that you choose will 
appear both in Project and in any resource information shared from Project. For 
example, in the default Gantt Chart view, the name of the resource appears next  
to the bars of the tasks to which that resource is assigned.

A resource might refer to somebody who is already on staff or to a position to be 
filled later. If you have not yet filled all the resource positions required, you might 
not have real people’s names to enter. In that case, use descriptive placeholder 
names or job titles when setting up resources in Project.

Entering Resource Capacity
The Max. Units field represents the maximum capacity of a resource to accomplish any 
task. Specifying that a resource has 100% maximum units means that 100 percent of 
that resource’s working time is available to work on assigned tasks in the project plan. 
Project will alert you if you assign the resource to more tasks than they can accomplish 
at 100% maximum units (in other words, if the resource becomes overallocated ). 100% 
is the default Max. Units value for new resources.

For a resource that represents not a specific person, but a category of interchangeable 
people with a common skill set, you can enter a larger Max. Units value to indicate 
the number of available people. Entering a Max. Units setting such as 800% for such a  
resource means that you can expect that eight individual people who all belong to that 
resource category will be available to work full time every workday. 

In this exercise, you adjust the Max. Units values to indicate one resource that represents 
multiple people, and another resource whose capacity to work in this project plan is less 
than full time.

	 1.	 Click the Max. Units field for the Copyeditors resource.

	 2.	 Type or select 400%, and then press Enter.

Tip  When you click a numeric value in a field like Max. Units, up and down arrows 
appear. You can click these to display the number you want, or simply type the number 
in the field.



60    Chapter 3  Setting Up Resources

Next you’ll update the Max. Units value for Sharon Salavaria to indicate that she 
works half time.

	 3.	 Click the Max. Units field for Sharon Salavaria, type or select 50%, and then press 
Enter.

Tip  If you prefer, you can enter maximum units as partial or whole numbers (.5, 1, 
4) rather than as percentages (50%, 100%, 400%). To use this format, on the File tab, 
click Options. In the Project Options dialog box, click the Schedule tab. In the Show 
assignment units as a box, click Decimal.

With these changes to Max. Units, Project will identify these resources as being 
overallocated when their assigned work exceeds their capacities. You will work with 
resource overallocation in Chapters 8 and 9.

Entering Resource Pay Rates
Almost all projects have some financial aspect, and cost limits the scope of many 
projects. Tracking and managing cost information allows the project manager to answer 
such important questions as the following:

●	 What is the expected total cost of the project based on our task durations and 
resource assignments?

●	 Are we using expensive resources to do work that less expensive resources 
could do?

●	 How much money will a specific type of resource or task cost over the life of the 
project?

●	 Are we spending money at a rate that we can sustain for the planned duration of 
the project?

You can enter standard rates and costs per use for work and material resources, as 
well as overtime rates for work resources. Cost resources do not use pay rates and are 
described later in this chapter. 
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When a work resource has a standard pay rate entered and is assigned to a task, Project 
calculates the cost of the assignment. Project does so by multiplying the assignment’s 
work value by the resource’s pay rate—both using a common increment of time (such 
as hours). You can then see cost per resource, cost per assignment, and cost per task 
(as well as costs rolled up to summary tasks and the entire project plan). You will assign 
resources to tasks in Chapter 4, “Assigning Resources to Tasks.”

Project handles overtime expenses differently. Project will apply the overtime pay rate 
only when you specifically record overtime hours for an assignment. You will find more 
information about working with overtime in Chapter 14, “Getting Your Project Back On 
Track.” Project does not automatically calculate overtime hours and associated costs be-
cause there’s too great a chance that it would apply overtime when you did not intend 
it. In the new book launch project plan, Jun Cao’s working schedule provides a good ex-
ample. In the next exercise, you will set up a working schedule of 10 hours per day, four 
days per week for Jun. This is still a regular 40-hour workweek, even though 2 hours  
per day could be mistaken for overtime with the normal assumption of an 8-hour day. 

In addition to or instead of cost rates, a resource can include a set fee that Project 
accrues to each task to which the resource is assigned. This is called a cost per use. Unlike 
cost rates, the cost per use does not vary with the task’s duration or amount of work the 
resource performs on the task. You specify the cost per use in the Cost/Use field in the 
Resource Sheet view.

In this exercise, you enter standard and overtime pay rates for work resource.

	 1.	 In the Resource Sheet, click the Std. Rate field for Jun Cao.

	 2.	 Type 42 and press Enter.

Jun’s standard hourly rate of $42 appears in the Std. Rate column. Note that the 
default standard rate is hourly, so you did not need to specify cost per hour.

	 3.	 In the Std. Rate field for Sharon Salavaria, type 1100/w and press Enter.

Sharon’s weekly pay rate appears in the Std. Rate column. 
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 	 4.	 Enter the following standard pay rates for the given resources:

Resource Name Standard Rate
Toby Nixon 2700/w
Toni Poe Leave at 0 (Toni is the book author and you’re not tracking 

her rate-based costs in this project plan)

Zac Woodall 55
Copyeditors 45

As you can see, you can enter pay rates with a variety of time bases—hourly (the 
default), daily, weekly, and so on. In fact, you can enter pay rates in all the incre-
ments of time for which you can enter task durations—from minutes to years.

Next, you will enter an overtime pay rate for one of the resources.

	 5.	 In the Overtime Rate field for Jun Cao, type 67, and then press Enter.

Tip  If you work with a large number of resources who have the same standard or 
overtime pay rates, you can set up Project to apply these pay rates automatically 
whenever you add a new resource. You do this in the Advanced tab of the Project 
Options dialog box, which is accessible from the File tab.

Project Management Focus: Getting Resource Cost Information
Work resources can account for the majority of costs in many projects. To take full 
advantage of the extensive cost management features in Project, the project man-
ager would ideally know the costs associated with each work resource. For people 
resources, it might be difficult to obtain such information. In many organizations, 
only senior management and human resource specialists know the pay rates of all 
resources working on a project, and they might consider this information confiden-
tial. Depending on your organizational policies and project priorities, you might 
not be able to track resource pay rates. If you cannot track resource cost informa-
tion and your project is constrained by cost, your effectiveness as a project man-
ager might be reduced, and the sponsors of your projects should understand this 
limitation. If you do include cost details in your project plan and this is considered 
sensitive information, consider requiring a password to open such project plans. To 
set a password, click the File tab, and then click Save As. In the Save As dialog box, 
click Tools and then click General Options.
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Adjusting Working Time for Individual Resources
Project uses different types of calendars for different purposes. In Chapter 2, “Creating 
a Task List,” you modified the project calendar to specify nonworking days for the 
entire project. In this exercise, you will focus on the resource calendar. A resource 
calendar controls the working and nonworking times of an individual resource. Project 
uses resource calendars to determine when work for a specific resource can be sched-
uled. Resource calendars apply only to work resources (people and equipment), not to 
material or cost resources.

When you initially create resources in a project plan, Project creates a resource calendar 
for each work resource. The initial working time settings for resource calendars exactly 
match those of the project calendar, which by default is the Standard base calendar. The 
Standard base calendar is built into Project and accommodates a default work schedule 
from 8 A.M. to 5 P.M., Monday through Friday, with an hour off for lunch each day. If 
all the working times of your resources match the working time of the project calendar, 
you do not need to edit any resource calendars. However, chances are that some of your 
resources will need exceptions to the working time in the project calendar—such as

●	 A flex-time work schedule

●	 Vacation time

●	 Other times when a resource is not available to work on the project, such as time 
spent training or attending a conference

Tip  If you have a resource who is available to work on your project only part time, you might 
be tempted to set the working time of the resource in your project to reflect a part-time 
schedule, such as 8 A.M. to 12 P.M. daily. However, a better approach would be to adjust 
the availability of the resource as recorded in the Max. Units field to 50%, as you did for the 
previous exercise for the resource named Sharon Salavaria. Changing the unit availability of 
the resource keeps the focus on the capacity of the resource to work on the project rather 
than on the specific times of the day when that work might occur. You set the maximum units 
for a resource in the Resource Sheet view. 

Changes that you make to the project calendar are reflected automatically in resource 
calendars derived from the same project calendar. For example, in Chapter 2, you speci-
fied a nonworking day for a staff morale event, and Project rescheduled all work to skip 
that day. 

In this exercise, you specify the working and nonworking times for individual work 
resources.

	 1.	 On the Project tab, in the Properties group, click Change Working Time.

The Change Working Time dialog box appears.
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	 2.	 In the For calendar box, click Toby Nixon.

Toby Nixon’s resource calendar appears in the Change Working Time dialog 
box. Toby has told you he will not be available to work on Thursday and Friday, 
January 19 and 20, because he plans to attend a book industry conference.

	 3.	 On the Exceptions tab in the Change Working Time dialog box, click in the 
first row directly below the Name column heading and type Toby attending a 
conference.

The description for the calendar exception is a handy reminder for you and others 
who may view the project plan later.

	 4.	 Click in the Start field and type or select 1/19/12.

	 5.	 Click in the Finish field, type or select 1/20/12, and then press the Enter key.

Tip  Alternatively, in the calendar you can first select the date or date range for which 
you want to create an exception, and then enter the exception name. Project will insert 
the Start and Finish dates automatically based on your selection, and then press the 
Enter key.

Every work resource calendar is based on the project calendar;
the default project calendar is the Standard base calendar.
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Project will not schedule work for Toby on these dates.

Tip  To set up a partial working time exception for a resource, such as a portion of a day 
when a resource cannot work, click Details. In the Details dialog box, you can also create 
recurring exceptions to the resource’s availability.

To conclude this exercise, you will set up a “4 by 10” work schedule (that is, 4 days 
per week, 10 hours per day) for a resource.

	 6.	 In the For box, click Jun Cao.

	 7.	 When prompted to save the resource calendar changes that you made for Toby 
Nixon, click Yes.

	 8.	 Click the Work Weeks tab in the Change Working Time dialog box.

	 9.	 Click [Default] directly under the Name column heading, and then click Details.

Next, you will modify the default working week days and times for Jun Cao.

	 10.	 Under Selected Day(s), select Monday through Thursday. 

These are the weekdays Jun can normally work.

	 11.	 Click Set day(s) to these specific working times. 

Next you’ll modify Jun’s regular daily schedule for the days she normally works.

	 12.	 In row 2, click 5:00 PM and replace it with 7:00 PM, and then press Enter.

Finally, you will mark Friday as a nonworking day for Jun.

	 13.	 Click Friday.

	 14.	 Click Set days to nonworking time.

Now Project can schedule work for Jun as late as 7 P.M. every Monday through 
Thursday, but it will not schedule work for her on Fridays. 

 	 15.	 Click OK to close the Details dialog box.
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You can see in the calendar in the Change Working Time dialog box that Fridays (as 
well as Saturdays and Sundays) are marked as nonworking days for Jun Cao. 

	 16.	 Click OK to close the Change Working Time dialog box.

Because you have not yet assigned these resources to tasks, you don’t see the 
scheduling effect of their nonworking time settings. You will observe this in 
Chapter 4.

Tip  If you find that you must edit several resource calendars in a similar way (to 
handle a night shift, for example), it may be easier to assign a different base calendar 
to a resource or collection of resources. This is more efficient than editing individual 
calendars, and it allows you to make project-wide adjustments to a single base calendar 
if needed. For example, if your project includes a day shift and a night shift, you can 
apply the Night Shift base calendar to those resources who work the night shift. You 
change a base calendar in the Change Working Time dialog box. For collections of 
resources, you can select a specific base calendar directly in the Base Calendar column 
on the Entry table in the Resource Sheet view.
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Setting Up Cost Resources
Another type of resource that you can use in Project is the cost resource. You can use a 
cost resource to represent a financial cost associated with a task in a project. While work 
resources (people and equipment) can have associated costs (hourly rates and fixed costs 
per assignment), the sole purpose of a cost resource is to associate a particular type of 
cost with one or more tasks. Common types of cost resources might include categories 
of expenses you’d want to track on a project for accounting or financial reporting pur-
poses, such as travel, entertainment, or training. 

Cost resources do no work and have no effect on the scheduling of a task. The Max. 
Units Standard and Overtime pay rates and Cost/Use fields do not apply to cost 
resources. After you assign a cost resource to a task and specify the cost amount per 
task, you can then see the cumulative costs for that type of cost resource, such as total 
travel costs in a project.

The way in which cost resources generate cost values differs from that of work resources. 
When you assign a work resource to a task, the work resource can generate a cost based 
on a pay rate (such at $40 per hour for the length of the assignment), a flat per-use 
cost (such as $100 per assignment), or both. You set up such pay rates and cost per use 
amounts once for the work resource, as you did in the section “Entering Resource Pay 
Rates” earlier in this chapter. However, you enter the cost value of a cost resource only 
when you assign it to a task. You can do so in the Cost field of the Assign Resources 
dialog box or in the Cost field of the Task Form with the Cost detail shown. 

Lucerne Publishing maintains a profit and loss (P&L) sheet for every book it publishes. 
Travel is a major expense incurred in a book launch. 

In this exercise, you’ll set up a cost resource. 

	 1.	 In the Resource Sheet, click the next empty cell in the Resource Name column.

	 2.	 Type Travel and press the Tab key.

	 3.	 In the Type field, click Cost.

You will assign a cost resource in Chapter 4.
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Documenting Resources
You might recall from Chapter 2 that you can record any additional information about 
a task, resource, or assignment in a note. For example, if a resource has flexible skills 
that can help the project, it is a good idea to record this in a note. In that way, the note 
resides in the project plan and can be easily viewed or printed.

In this exercise, you enter resource notes relevant to the new book launch project. 
In Chapter 2, you entered a task note via the Notes button on the Task tab of the 
Properties group. You can enter resource notes in a similar way (via the Notes button 
on the Resource tab of the Properties group) but in this exercise, you’ll use a differ-
ent method. You’ll use the Resource form, which allows you to view and edit notes for 
multiple resources more quickly.

In this exercise, you’ll enter notes in the Resource Form.

	 1.	 In the Resource Name column, click Toby Nixon.

	 2.	 On the Resource tab, in the Properties group, click the Details button.

Tip  You can also click Details, Resource Form on the View tab of the Split View group. 

The Resource Form appears below the Resource Sheet view. 
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In this type of split view, details about the selected item in the upper view (a 
resource, in this case) appear in the lower view. You can quickly change the select-
ed resource name in the upper view by clicking directly on a name, using the up 
arrow or down arrow keys, or by clicking Previous or Next in the Resource Form.

The Resource Form can display one of several details; initially it displays the 
Schedule details. Next you’ll switch it to display the Notes details.

	 3.	 Click anywhere in the Resource Form.

	 4.	 On the Format tab, in the Details group, click Notes.

Tip  You can also right-click in the gray background area of the Resource Form and, in 
the shortcut menu that appears, click Notes.

The Notes details appear in the Resource Form. 

	 5.	 In the Notes box, type Toby worked on launch campaigns for Toni Poe’s 
previous two books.

Notice that as soon as you started typing the note, the Previous and Next buttons 
changed to OK and Cancel. 

	 6.	 Click OK.

In the Resource Sheet view, a note icon appears in the Indicators column.
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	 7.	 Point to the note icon that appears next to Toby’s name in the Resource Sheet.

The note appears in a ScreenTip. For notes that are too long to appear in a 
ScreenTip, you can double-click the note icon to display the full text of the note. 
You can also see more of long notes in the Resource Form or in the Resource 
Information dialog box.

To conclude this exercise, you’ll add a note for one more resource.

	 8.	 In the Resource Form, click Previous to shift the focus to Sharon Salavaria and 
display her details.

Tip  You can also click on Sharon’s name in the Resource Sheet view above the Resource 
Form. 

	 9.	 In the Notes box, type Sharon’s standard pay rate is adjusted for her half-time 
work schedule. Then click OK.

Finally, you’ll close the Resource Form. 
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	 10.	 On the Resource tab, in the Properties group, click the Details button.

The Resource Form is closed, leaving the Resource Sheet displayed. 

In this exercise, you’ve entered notes for some resources. This information is unique 
to those resources.

CLEAN UP  Close the Simple Resources file.

Key Points
●	 Recording resource information in your project plans helps you better control who 

does what work when and at what costs.

●	 Work resources (people and equipment) perform the work in a project.

●	 Cost resources account for the types of expenses that you may wish to track across 
a project.
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Entire Project command (View tab)

consolidating project plans, 422
scheduling summary tasks, 173
viewing critical path, 171, 226

entry bar (formula bar), 7
Entry table

accessing, 248
as default, 235
copying project data, 373
modifying, 248
task ID numbers, 38
viewing project tasks, 340

EPM. See Enterprise Project Management (EPM)
equipment resources, setting up, 57–58
Excel worksheets. See Microsoft Excel
Existing Tasks command (Format tab), 101
Exit command (File tab), 9
export maps, 377, 382–83
Export Wizard, 383–84

F
FF task relationship. See finish-to-finish (FF) 

task relationship
fields, creating custom, 251



462    file formats

file formats
from previous versions, 386
legacy files, 383
opening other, 377–82
saving to other, 382–86
task lists in other, 377

File tab. See also Project Options dialog box
Close, 8
displaying Backstage view, 8, 52
Exit, 9
Help, 9
Info, 8, 348
New, 7–8, 25, 400
Open, 7–9, 400
Print, 8, 110
Recent, 8
Save, 7–8
Save & Send, 8, 338
Save As, 8, 10, 95, 286

files
managing, 7–10
opening, 9

Filter button (View tab)
Clear Filter, 284, 289
Display AutoFilter, 235
functionality, 243, 285
Incomplete Tasks, 312
Late Tasks, 281
More Filters dialog box, 245, 283, 285, 288
Slipped/Late Progress, 281
Slipping Tasks, 281

Filter Definition dialog box, 245–46
filter indicator, 245
filtering

for delayed/slipping tasks, 281
global templates and, 346
project details, 242–48
visual reports, 387

finish date, project, 228, 302
Finish No Earlier Than (FNET) constraint type, 148
Finish No Later Than (FNLT) constraint type, 148
finish-to-finish (FF) task relationship, 38, 142
finish-to-start (FS) task relationship, 38, 142
fixed consumption rates, 199
fixed costs

assigning to tasks, 167
defined, 166
determining accrual methods, 166
examples of, 166

fixed-duration task type, 158, 194
fixed-unit task type

as default, 158
assigning material resources, 198
defined, 87

fixed-work task type, 158

float (slack), 171
Fluent user interface. See ribbon interface
FNET constraint type. See Finish No Earlier Than 

(FNET) constraint type
FNLT constraint type. See Finish No Later Than 

(FNLT) constraint type
Font Color button, 327
Font group (Format tab)

Background Color button, 327
Font Color button, 327
Italic, 326

Font group (Task tab), 11
Format Bar dialog box, 99
Format Bar Styles button (Format tab), 14–15
Format Drawing dialog box, 105
Format group (Format tab)

Bar Styles, 332
Box Styles, 328
Gridlines, 100, 323
Layout, 154, 324
Text Styles button, 324

Format tab. See also Details group (Format tab); 
Format group (Format tab)

Assignment group, 191, 193, 195, 197
Bar Styles group, 99, 172
Columns group, 250, 293
Current Selection group, 103
Drawings group, 105
Font group, 326–27
functionality, 11
Gantt Chart Style group, 14, 96
Insert group, 101
label changes, 17
Show/Hide group, 95, 422
Text group, 324–25

formatting
Calendar view, 331–33
Gantt Chart view, 95–101, 318–24
Network Diagram view, 327–31
task names visually, 98–100
Timeline view, 324–27
Tracking Gantt view, 318–23

formula bar (entry bar), 7
Formula dialog box, 294
free slack, 171–72
FS task relationship. See finish-to-start (FS) 

task relationship

G
Gantt bars

attaching text boxes to, 106
customizing Gantt Chart view, 94–101
defined, 93
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for recurring tasks, 169
for summary tasks, 174
identifying task slippage, 283–84
nonworking time and, 131
scrolling to tasks, 96

Gantt Chart Style group (Format tab)
Format Bar Styles button, 14–15
More button, 14, 96

Gantt Chart view
accessing, 127, 168, 172
adjusting resource assignments, 83
applying Schedule table, 172
as default view, 94
assigning material resources, 198
assigning work resources, 77, 80–81
changing task default settings, 86
changing timescale, 104
components, 94
copying, 106–109
copying project data, 373
creating project dependencies, 424
customizing, 94–101
deadline indicators, 164
depicted, 19
drawing considerations, 104–106
filtering project details, 243–46
formatting, 95–101, 318–24
Gantt bars, 93
highlighting critical path, 302
orange vertical line, 26
overview, 15, 318
pan and zoom controls, 104
pasting graphic images, 372
Print Preview option, 110
printing, 109–15
printing options, 334–39
project summary tasks, 95
recording macros, 353
rescheduling incomplete work, 275
ScreenTips in, 214, 260
scrolling, 104
sharing custom elements, 348
splitting tasks, 196
task relationships, 38, 40
task scheduling and, 27
troubleshooting problems, 306, 309–310
updating assignments in sharer plans, 406
viewing project tasks, 340
viewing resource names, 59

Gantt Chart with Timeline view, 15, 94, 342
GIF image files

copying, 107
editing macros, 356, 360
macro names, 352
recording macros, 355

global templates
defined, 346
elements supported, 346–47
project plans and, 346–47
storing macros, 352

Go To command/dialog box
adding to Quick Access toolbar, 363
shortcut keys and, 160, 302, 352

Gridlines command (Format tab), 100, 323
Group Definition dialog box, 240–41
grouping project details, 238–42
groups (ribbon interface), 6, 346

H
Help command (File tab), 9
Hide Subtasks command (View tab), 201, 214
highlighting

critical path, 302
defined, 243

HTML. See Hypertext Markup Language (HTML)
hyperlinks to tasks, 51
Hypertext Markup Language (HTML), 372

I
import maps, 377, 383
Import Wizard, 378–81
Inactivate command (Task tab), 176, 313
Indent Task command (Task tab), 36–37
Info command (File tab), 8, 348
Insert Column command (Format tab), 250
Insert group (Format tab), 101
Insert group (Project tab), 421
Insert group (Task tab)

Milestone, 34
Summary, 37
Task button, 168

Insert Hyperlink dialog box, 51
Insert Project dialog box, 421
interim plans, saving, 262

L
lag time, 142–44
Late/Overbudget Tasks Assigned To filter, 289
Late Tasks filter, 281
Layout button (Format tab), 154, 324
lead time, 142–44
legacy files, 383
Level group (Resource tab), 223
Level Resources dialog box, 220
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Leveling Gantt view, 226, 318
leveling, resource. See resource leveling
Link Tasks command (Task tab), 39–40, 45
linking

drawn objects, 104
project plans to resource pools, 403, 413–15
tasks, 37–42
tasks between projects, 423–28

M
macros

editing, 356–62
naming conventions, 352
recording, 351–56
security considerations, 355
storing, 352

Macros dialog box, 355, 357, 360
Macros group (View tab)

Macros dialog box, 355, 357, 360
Record Macro dialog box, 352
Stop Recording, 354

maps, import/export, 377, 382–83
manually scheduling tasks, 30–34
Mark On Track button (Task tab), 134
master projects, defined, 420
material resources

assigning to tasks, 198–99
defined, 55, 186
setting up, 186–87
variable consumption rates, 199

Max. Units field
examing resource allocations, 211
functionality, 59–60, 74, 179, 181
resource calendars and, 63

MCTS. See Microsoft Certified Technology 
Specialist (MCTS)

menus, tabs as replacements, 7
MFO constraint type. See Must Finish On (MFO) 

constraint type
Microsoft Certified Technology Specialist (MCTS), 440
Microsoft Excel

as editable format, 286
AutoFill handle, 196
AutoFilters, 243
copying project data to, 372–76
generating visual reports, 386–91
opening file format from, 377–82
Paste Special feature, 372
PivotChart feature, 387
PivotTable feature, 387, 389
Resource Cost Summary report, 293
saving supported formats, 382

Microsoft Project 2010. See Project 2010

Microsoft Project Document Object, 372
Microsoft Project Server, 443–44
Microsoft Project User Group (MPUG), 440
Microsoft SharePoint, synchronizing task lists, 

391–95
Microsoft Visual Basic for Applications (VBA),  

351, 356–62
Microsoft Word, 372–76
Milestone command (Task tab), 34
milestones

adding to Timeline view, 102–103
adjusting colors, 96, 99
defined, 34
entering, 34
formatting indicator, 99
on Gantt charts, 93
marking tasks as, 35

mini-toolbars, 7, 98
Mode command (Task tab), 45
More button (Format tab), 14, 96
More Filters dialog box

Cost Overbudget, 288
functionality, 245, 285
Late/Overbudget Tasks Assigned To, 289
Slipping Tasks, 284

More Groups dialog box, 240
More Tables dialog box, 248–50
More Views dialog box, 226, 252
MPUG. See Microsoft Project User Group (MPUG)
MSO constraint type. See Must Start On (MSO) 

constraint type
Multiple Baselines Gantt view, 318
Must Finish On (MFO) constraint type, 148, 163
Must Start On (MSO) constraint type

cautions using, 149
defined, 148
negative slack and, 152

My Commands group (Custom tab), 367

N
naming conventions

for macros, 352
for resource pools, 401

navigating in Gantt Chart view, 104
negative slack, 152
Network Diagram view

filtering support, 243
formatting, 327–31
functionality, 327
task relationships, 38

New command (File tab)
creating project plans, 25, 400
functionality, 7–8
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New Window command (View tab), 12, 423
nonworking days, 46–48, 131
Notepad, 372, 384–85
notes. See specific types of notes

O
OLAP. See Online Analytical Processing (OLAP)
OLE objects, 372
ongoing operations, defined, 431
Online Analytical Processing (OLAP), 387
Open command (File tab)

creating resource pools, 400
functionality, 7–9

opening
files, 9
other file formats, 377–82
resource pools, 409, 414
sharer plans, 416–19

Options command (File tab). See Project Options 
dialog box

Organizer feature
accessing, 348
Calendars tab, 348–50
depicted, 348
functionality, 347–48

Outline command (View tab)
All Subtasks, 174, 288, 421
Hide Subtasks, 201, 214
Outline Level 1, 173, 288

overallocations (resources)
defined, 212
evaluating, 212
resolving, 216–20

Overbudget Resources report, 292
Overbudget Tasks report, 289
overtime hours, assigning, 306
OvertimeRate field, 62
Overview Reports dialog box, 116

P
Page Setup dialog box, 114, 119, 335–37
pan controls, 104
passwords, setting, 62
Paste Special feature, 372
pasting data. See copying
pay rates

applying at different times, 184–85
multiple, 183–84

PDF format, 286, 337–38
peak units, 158–59
people resources. See work resources

phases. See also summary tasks
bottom-up planning, 36
defined, 36
organizing tasks into, 35
top-down planning, 36

pivot diagrams, 331
Planning Wizard, 313
PMI. See Project Management Institute (PMI)
predecessor tasks, 37, 142–44
presentations, copying views for, 106
Print command (File tab), 8, 110
Print Preview window

Backstage view, 110, 335, 341
Gantt Chart view, 110
Multiple Pages option, 110, 113
Page Right option, 113
Page Setup option, 114
Print Specific Dates option, 111
Settings option, 111
Timeline view, 110
viewing reports, 115–16
zoom controls, 337

printing
reports, 115–20, 339–42
views, 109–15, 334–39

product scope, defined, 29
Project 2010

active view, 6
editions supported, 4
interface components, 6–7
starting, 5

project baseline, saving, 124–27
project calendars. See also base calendars

functionality, 46
global templates and, 346

project costs
checking, 227–30
examining resource costs, 290–93
examining task costs, 287–90
in project triangle model, 299, 434
managing project constraints, 435–37
reporting variance in, 293–96
troubleshooting problems, 307–311

project dependencies, creating, 423–28
project details

filtering, 242–48
grouping, 238–42
sorting, 234–38

project duration. See durations
project finish date, 228, 302
Project Information dialog box

checking plan duration, 49–50
checking project finish dates, 229–30
creating project plans, 26
depicted, 229
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identifying task slippage, 282
troubleshooting problems, 301
viewing statistics, 74, 90

Project learning communities, 439–40
Project Management Institute (PMI), 441
Project Options dialog box

accessing, 254
applying pay rates automatically, 62
breaking task/assignment relationships, 273
changing default view, 94
cross-project links, 428
Customize Ribbon tab, 364–67
default start/end dates, 152
displaying entry bar, 7
entering actual costs manually, 269
functionality, 9
grouping project details, 239
honoring relationships over  

constraints, 152
identifying tasks on critical path, 172
Quick Access Toolbar tab, 362–63
rescheduling incomplete work, 276
Trust Center dialog box, 377–78, 385–86
Work Is Entered In box, 272

project plans
assigning resources, 73
automating task scheduling, 43–45
breaking link with resource pools, 403
checking cost/finish date, 227–30
checking duration, 49–50
consolidating, 420–23
copying views, 106–109
creating, 24–27, 400
customizing Gantt Chart view, 94–101
customizing reports, 115–20
customizing Timeline view, 101–103
data considerations, 93
documenting, 50–53
drawing on Gantt charts, 104–106
entering durations, 30–33
entering milestones, 34
entering task names, 27–29
evaluating resource allocations, 212–17
examining resource allocations, 211–12
Gantt charts and, 94
global templates and, 346–47
leveling resource allocations, 154,  

217, 220–26
linking to resource pools, 413–15
linking tasks, 37–42
organizing tasks into phases, 35
printing reports, 115–20
printing views, 109–15
resolving overallocations, 217–20
saving project baselines, 125

setting nonworking days, 46–48
sharing custom elements, 346–51
storing macros, 352
updating baselines, 259
viewing resource capacity, 200–202

project scope
defined, 29
in project triangle model, 299, 434
managing project constraints, 435–37
task durations and, 30
troubleshooting problems, 311–14
viewing resource capacity, 200–202

Project Server, 443–44
Project Statistics dialog box, 50, 282
project status

examining resource costs, 290–93
examining task costs, 287–90
identifying task slippage, 280
identifying variance, 281–86
reporting, 286
reporting variance in project costs, 293–96

Project Summary Task (Format tab),  
95, 422

Project tab. See also Properties group (Project tab); 
Reports group (Project tab)

functionality, 11
Insert group, 421
Schedule group, 126, 261–63
Status group, 128, 275

project tracking
actual values for tasks/assignments, 125,  

132–36, 263–68
as scheduled, 128–29
completion percentage for tasks, 125, 129–32
considerations, 123
remaining values for tasks/assignments,  

263–68
rescheduling incomplete work, 274–76
saving interim plans, 262–63
saving project baseline, 124–27
timephased actuals, 258, 269–73
updating baseline plans, 258–62

project triangle model, 299, 432–35
projects, defined, 3, 431–32
Properties dialog box, 52
Properties group (Project tab). See also Project 

Information dialog box
Change Working Time, 46, 63, 155, 408, 410–13
Task Notes, 51, 68

Properties group (Resource tab)
Details button, 68, 71
Information, 181, 184

Properties group (Task tab)
Add to Timeline, 103
Information, 39, 145, 150, 152, 157, 159
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Q
Quick Access toolbar

adding commands, 363
customizing, 362–67
overview, 6
removing commands, 364

R
Recent command (File tab), 8
Record Macro dialog box, 352–53
recording macros, 351–56
Recurring Task Information dialog box, 168, 170
recurring tasks, setting up, 167–70
remaining costs, 227
remaining values for tasks, 263–68
Rename dialog box, 365–67
renumbering tasks, 234
Replace Resource dialog box, 310
Reports dialog box

accessing Overbudget Resources report, 292
accessing Slipping Tasks report, 286
displaying available reports, 115, 339

Reports group (Project tab)
Budget Cost report, 289
Overbudget Resources report, 292
Overbudget Tasks report, 289
Project Summary report, 286
Reports dialog box, 115, 117, 286, 292, 339
Resource Cost Summary report, 293
Slipping Tasks report, 286
Visual Reports, 286, 289, 293, 387–91

reports/reporting
customizing, 115–20
defined, 339
functionality, 115
generating in Excel, 386–91
global templates and, 346
printing, 115–20, 339–42
project status, 286
stoplight reports, 293–96
variance in project costs, 293–96
viewing, 115–16
Visio visual reports, 331, 386–91

Reset button, 367
resource allocations

evaluating, 212–17
examining over time, 211–12
leveling, 154, 217, 220–26
resolving overallocations, 217–20
viewing in resource pools, 404–405

resource assignments. See also tasks
adjusting, 83, 203–208

applying contours to, 192–96
applying different cost rates, 196–97
assigning cost resources, 88–90
assigning work resources to tasks, 74–81, 89–90
controlling work with, 82–87
delaying start of, 191
editing values, 194–95
to recurring tasks, 169–70
removing work resources, 84
starting at specific times, 192
tracking actual/remaining values, 263–68
tracking timephased actuals, 269–73
updating in sharer plans, 406–407
variable consumption rates, 199
viewing capacity, 200–202
viewing in resource pools, 404–405

resource availability/capacity
defined, 212
entering, 59–60
setting up, 179–83
viewing, 200–202

resource calendars
adjusting working time for tasks, 155
defined, 63
examing resource allocations, 211
Max. Units field, 63
work resources and, 63

resource costs, examining, 290–93
Resource Form

documenting resources, 68
Notes details, 69
Task Form and, 78
viewing assignments in resource pools, 405

Resource Graph view, 217, 221
resource groups

grouping project details, 238–42
sorting project details, 234–38

Resource Information dialog box
customizing Max. Units values, 181–82
entering different pay rates, 185
entering multiple pay rates, 183–84

resource leveling
delaying, 217
for overallocated resources, 220–26
functionality, 222
split tasks and, 154

Resource Leveling dialog box, 223–26
resource management. See also specific types of 

resources
adjusting working time individually, 63–66
assigning resources, 73
collecting actuals, 273
cost information, 62
documenting resources, 68–71
entering fixed costs, 165–67
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entering resource capacity, 59–60
entering resource names, 59
entering resource pay rates, 60–62
grouping information, 238–42
Max. Units field, 59
saving project baseline, 125
setting up work resources, 56
sorting data, 234–38
troubleshooting problems, 307–11
types of resources, 55

resource notes
assignment notes and, 195
defined, 50
entering, 68–71
pasting graphic images, 372

Resource Pool command (Resource tab)
Share Resources, 402, 415
Update Resource Pool, 416, 418

resource pools
benefits, 399
breaking link with project plans, 403
creating, 398–403
dedicated, 404
functionality, 398
linking project plans, 413–15
naming conventions, 401
opening, 409, 414
troubleshooting problems, 416
updating information in, 408–10, 416–19
updating working times in, 411–13
viewing assignment details, 404–405

Resource Sheet view
accessing, 180, 222, 235
copying project data, 374
creating resource pools, 401
depicted, 17
documenting resources, 69
Entry table, 235
examining resource costs, 290
grouping information, 239
leveling resources, 222
linking project plans, 414
Resource Form, 68
Resource Information dialog box, 183
setting up cost resources, 67
setting up material resources, 186–87
setting up resources, 57–58
sorting, 235
Std. Rate field, 61
troubleshooting problems, 307

Resource tab. See also Assignments group 
(Resource tab)

functionality, 11
Level group, 223
Properties group, 68, 71, 181, 184

Resource Usage view
depicted, 18
evaluating resource allocation, 213, 215
examining resource costs, 293
functionality, 18, 192
hiding assignment details, 339
linking project plans, 414
Next Overallocation button, 216
resolving resource overallocations, 219
ScreenTips in, 214
scrolling horizontally, 215
tracking timephased work, 273
viewing assignments in resource pools,  

404–405
viewing resource capacity, 201

Resource Views group (View tab). See also 
Resource Sheet view

Other Views, 217
Resource Usage, 18, 201, 404
Team Planner, 203
viewing other views, 20

Respect Links command (Task tab), 42
ribbon interface

as toolbar replacement, 7
customizing, 362–67
finding features, 11–15
group divisions, 6
overview, 6

S
Save & Send command (File tab), 8, 338
Save As command (File tab)

editable formats, 286
functionality, 8, 10, 95

Save command (File tab), 7–8
saving

interim plans, 262–63
project baseline, 124–27
to other file formats, 382–86

Schedule group (Project tab), 126,  
261–63

Schedule group (Task tab)
100% Complete, 130
50% Complete, 131
Inactivate, 176, 313
Indent Task, 36–37
Link Tasks, 39–40, 45
Mark on Track button, 134–35
Respect Links, 42
Split Task, 153
Update Tasks, 129, 134–35, 359

Schedule table, 172
scheduling formula, 81, 158–59
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ScreenTips
assignment dates, 214
calendar details, 158
describing work contours, 194
displaying date values in, 195, 271
displaying progress, 131
in Gantt Chart view, 214, 260
notes displaying in, 51, 70
splitting tasks, 153
viewing constraint details, 150

Scroll to Task command (Task tab), 96, 107, 145–46
scrolling in Gantt Chart view, 104
security considerations, 355
Selected Tasks command (View tab), 426
Set Baseline dialog box

accessing, 261
controlling baseline updates, 262
depicted, 126
saving interim plans, 263

SF task relationship. See start-to-finish (SF) task 
relationship

Share Resources dialog box
creating resource pools, 402–403
linking project plans, 415
troubleshooting problems, 416

SharePoint, synchronizing task lists, 391–95
sharer plans

consolidating information in, 403
defined, 398
opening, 416–19
troubleshooting problems, 416
updating assignments in, 406–407
updating working times in resource pools, 411–13

shortcut menus, accessing, 7
Show/Hide group (Format tab), 95, 422
Simple Tracking Start project plan, 126
slack (float), 171
Slipped/Late Progress filter, 281
Slipping Tasks filter, 281, 286
SNET constraint type. See Start No Earlier Than 

(SNET) constraint type
SNLT constraint type. See Start No Later Than (SNLT) 

constraint type
Sort dialog box

functionality, 12, 236–38
re-sorting resources by ID, 292

sorting project details, 234–38
Split Task command (Task tab), 153
Split View group (View tab)

Details, 19, 77, 306, 405
Timeline check box, 16–17, 49, 306, 327

SS task relationship. See start-to-start (SS) task 
relationship

Standard base calendar, 63, 155
Start menu

All Programs, 108, 384
starting Project 2010, 5

starting Project 2010, 5
Start No Earlier Than (SNET) constraint type

defined, 148
usage examples, 149–50, 167

Start No Later Than (SNLT) constraint type, 148
start-to-finish (SF) task relationship, 38, 142
start-to-start (SS) task relationship, 38, 142, 147
Statistics dialog box, 301
Status bar

functionality, 7
highlighting support, 243
Zoom In/Out controls, 217

Status group (Project tab), 128, 275
Std. Rate field, 61–62
Stop Recording command (View tab), 354
stoplight reports, 293–96
storing macros, 352
subprojects, defined, 420
subtasks

creating, 36–37
defined, 35
deleting, 313
reports and, 339

successor tasks, 37, 142–44
Summary command (Task tab), 37
Summary table

accessing, 235
depicted, 235
modifying, 248

summary tasks. See also phases
adding to Timeline view, 102
creating, 37
defined, 35
deleting, 313
displaying, 95
displaying as callouts, 103
inactivating, 176
linking, 41
on Gantt charts, 93, 95
reports and, 339
scheduling, 35, 172–75

Switch Windows command (View tab), 348, 350, 406
synchronizing task lists, 391–95

T
Table Definition dialog box, 249–50
tables

copying data to other programs, 373–76
creating, 248–50
customizing, 248–51
defined, 248
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global templates and, 346
manipulating columns, 250

Tables command (View tab). See also Cost table
Entry table, 127
More Tables, 248
Summary table, 235
Variance, 281, 284
Work table, 133, 264, 290

tabs (ribbon interface)
as menu replacements, 7
finding features, 11–15
overview, 6

task bar, changing colors, 327
task calendars, 155–58
task costs, examining, 287–90
task durations. See durations
Task Form

assigning work resources, 77–78
changing task default settings, 86
depicted, 19
editing values, 19
Resource Form and, 78
scheduling formula, 82
troubleshooting problems, 307
viewing task types, 159

Task Information dialog box
applying calendars to tasks, 157
applying constraints to tasks, 150
changing task relationships, 145–46
changing task types, 162
entering deadline dates, 165
entering notes in, 51
linking tasks, 39
manipulating lead/lag times, 143–45
marking tasks as milestones, 35
removing constraints, 152
sharing custom elements, 351
viewing task types, 159

Task Inspector pane
constraint details, 151
functionality, 144
scheduling details, 146

task lists
in other file formats, 377
synchronizing, 391–95

task names
entering, 27–29
making visible, 103
reformatting visually, 98–100

task notes
accessing, 50
assignment notes and, 195
entering, 50
pasting graphic images, 372

Task Notes command (Project tab), 51, 68

Task Range filter, 243
task relationships

adjusting, 142–47
creating, 39
critical path and, 170
defined, 38, 142

Task report, 340
Task Report dialog box, 341
task scheduling

automatic, 30
constraints and, 148, 163
critical path and, 170
effort-driven, 87–88, 158, 163
entering deadline dates, 163–65
identifying potential conflicts, 174
manual, 25, 30
presentation style and, 98
recurring tasks, 170
rescheduling incomplete work, 274–76
saving project baseline and, 125
scheduling formula, 81, 158–59
setting nonworking days, 46–48
split tasks and, 154
summary tasks, 35, 172–75
switching, 43–45
tracking progress, 128–29
troubleshooting problems, 300–306

Task Sheet view
accessing, 126, 167, 228, 248
applying Schedule table, 172
creating tables, 248–50
examining task costs, 287–88
functionality, 18
identifying task slippage, 284
stoplight reports and, 293

Task tab. See also Properties group (Task tab); 
Schedule group (Task tab)

Clipboard group, 11, 107, 286, 354, 374, 376
Editing group, 96, 107, 145–46
Font group, 11
functionality, 11
Insert group, 34, 37, 168
Tasks group, 43–45, 144
View group, 11, 171, 198

task types
changing, 158–63
effort-driven scheduling and, 158, 163
fixed-duration, 158, 194
fixed-unit, 87, 158, 198
fixed-work, 158
viewing, 159

Task Usage view
accessing, 160, 264
adding columns to, 160
comparing baseline and scheduled work, 290
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examining resource costs, 293
functionality, 19, 160, 190, 192
hiding assignment details, 339
tracking timephased work, 273
vertical divider bar, 264
viewing variances for assignments, 286, 290

Task Views group (View tab)
Calendar, 13, 332
Gantt Chart button, 13, 19, 127, 168, 172, 259
Network Diagram, 328
Other Views, 20, 126, 167, 226, 248, 252
Task Usage, 160, 264

tasks. See also resource assignments; summary tasks
Actions button, 83
adjusting working time, 155–58
assigning cost resources to, 88–90
assigning fixed costs to, 167
assigning material resources to, 198–99
assigning work resources to, 74–81, 89–90
associating costs with, 166
bottom-up planning, 36
changing default settings, 86
completion percentages, 125, 129–32
controlling work calculations, 82–87
on critical path, 171
defined, 23, 27
defining for deliverables, 29
documenting, 50–53
entering actual values, 125, 132–36
entering deadline dates, 163–65
filtering project details, 242–48
on Gantt charts, 93
grouping project details, 238
hyperlinking to information, 51
identifying slippage, 280
inactivating, 175–76
increasing durations for, 85
interrupting work, 153–54
linking, 37–42
linking between projects, 423–28
marking as milestones, 35
organizing into phases, 35
predecessor, 37
reactivating, 176
recurring, 167–70
removing working resources from, 84–85
renumbering, 234
resassigning, 208
rescheduling incomplete work, 274–76
resource leveling and, 154, 221
selecting quickly, 160
setting constraints, 147–52
setting nonworking days, 46–48
sorting project details, 234–38
splitting into segments, 154, 196

successor, 37
top-down planning, 36, 173
tracking actual/remaining values,  

263–68
tracking timephased actuals, 269–73
updating baselines, 259

Tasks group (Task tab)
Auto Schedule, 43–45
Inspect, 144
Mode, 45

Team Planner view, 203–208, 217
templates

creating project plans, 25
global, 346
sources of, 10
viewing available, 10

text boxes
attaching to Gantt bars, 106
attaching to timescale, 106

Text group (Format tab), 324–25
Text Styles button (Format tab), 324–25
time considerations. See durations
Timeline view

adjusting horizontal divider, 102
checking plan duration, 49
copying, 106–109
customizing, 101–103
formatting, 324–27
functionality, 16, 101, 104
hiding, 17, 327
pan and zoom controls, 104
Print Preview option, 110
printing, 109–15, 337–39

timephased fields
functionality, 125
peak units, 158–59
tracking actuals, 258, 265–73

timescale
attaching text boxes to, 106
changing in Gantt Chart view, 104
contouring assignments, 193
graphing allocations against, 217

Timescale box (View tab)
adjusting, 16
Days, 208, 215, 218
Months, 202, 215
Thirds of Months, 353
Weeks, 206, 217, 260, 272, 282, 302, 323

Timescale dialog box (Gantt Chart view), 131
toolbars

Quick Access toolbar, 6, 362–67
ribbons as replacements, 7

Tools menu, 170
top-down planning, 36, 173
total slack, 171
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Tracking Gantt view
accessing, 13, 259
formatting, 318–23
Gantt Chart view and, 318
identifying task slippage, 282
updating baselines, 259–60
viewing tasks with variance, 281

tracking projects. See project tracking
Tracking table, accessing, 133
troubleshooting problems

cost and resources, 307–311
resource pools, 416
scope-of-work issues, 311–14
sharer plans, 416
time and resource, 300–306

Trust Center dialog box, 377–78, 385–86

U
underallocation (resources), 212
Uniform Resource Locator (URL), 392
units of work (scheduling formula), 81, 158–59
Update Project dialog box, 128, 275
Update Resource Pool command (Resource tab), 

416, 418
Update Tasks dialog box

accessing, 129
editing macros, 359
entering actual values for tasks, 134–35

URL. See Uniform Resource Locator (URL)
Usage table, 213

V
variable consumption rates, 199
variance. See also troubleshooting problems

defined, 257
examining resource costs, 290–93
examining task costs, 287–90
identifying, 281–86
reporting for project costs, 293–96

Variance table
accessing, 127, 284
identifying task slippage, 284
viewing tasks with variance, 281

VBA. See Microsoft Visual Basic for Applications 
(VBA)

VBA Editor, 357–62
View Definition dialog box, 252–53
View group (Task tab)

functionality, 11
Gantt Chart, 198
other views, 171

View label, 6
View shortcuts, 6
View tab. See also Data group (View tab); Resource 

Views group (View tab); Split View group (View 
tab); Task Views group (View tab); Zoom group 
(View tab)

functionality, 11–12
Macros group, 352, 354–55, 357, 360
New Window, 12
Sort, 12
Split View group, 306
Window group, 348, 350, 401, 406, 423

View toolbar, 16
views

applying in views, 248
copying, 106–109
customizing, 251–54, 346
customizing Gantt Chart view, 94–101
customizing Timeline view, 101–103
defined, 15
filtering support, 243
global templates and, 346
grouping information, 238–42
printing, 109–115, 334–39
reports and, 339

Visio visual reports, 331, 386–91
Visual Basic for Applications (VBA). See Microsoft 

Visual Basic for Applications (VBA)
visual reports

Budget Cost report, 289
Excel supported, 387
Resource Cost Summary report, 293
status-focused, 286
Visio supported, 331, 386–91

Visual Reports dialog box
Budget Cost report, 289
generating reports, 387–91
Resource Cost Summary report, 293
status-focused reports, 286

W
WBS. See Work Breakdown Structure (WBS)
Window group (View tab)

Arrange All, 401
New Window, 12, 423
Switch Windows, 348, 350, 406

WordPad, 108, 372
Work Breakdown Structure (WBS), 328–29
work resources

adjusting assignments, 83–87
adjusting time for, 63–66
applying pay rates at different times, 184–85
assigning to tasks, 74–81, 89–90
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controlling work calculations, 82–87
costs incurred with, 88
defined, 55, 211
entering names, 59
equipment resources, 57–58
examing resource allocations, 211
multiple pay rates, 183–84
resource calendars and, 63
setting nonworking days, 46–48
setting up, 56
updating working times in resource pools, 411–13

Work table
accessing, 133
changing details in, 264, 268
components, 133
displaying work variance, 290

work units (scheduling formula), 81, 158–59

X
XML format, 382
XPS format, 286, 337–38

Z
zoom controls

accessing on View toolbar, 16
in Print Preview window, 337
in Timeline view, 104
on Status bar, 217

Zoom dialog box, 354
Zoom group (View tab). See also Timescale box 

(View tab)
Entire Project, 171, 173, 226, 422
Gantt Chart view, 16
Selected Tasks, 426
Zoom, 357

Zoom slider, 6
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